
INTRODUCTION

GO | Procedural
The creation of 3D animation and visual effects involves a number of  
stages which come together to create a complete artistic vision. Throughout 
this process, 3D artists like yourself explore and refine ideas in order to meet  
the creative needs of the project while hitting many tight deadlines. 
With Houdini, you have access to a node-based procedural workflow which 
makes it easier to manage and control the underlying flow of data which 
defines how your models, materials, animation and visual effects are working. 
This control makes it easier to step in and make changes where needed as 
the nodes update to show the new results. This frees you up to explore and 
prototype ideas early in production then come back and refine and scale the 
solution to create final shots.
As you work through these lessons, you will see how Houdini’s procedural  
approach has been designed from the ground up to support artists and  
technical directors working in production.  Its procedural architecture makes  
it easier for you to create directable CG shots, explore multiple iterations  
and hit deadlines no matter how tight they are. And most importantly, you  
will accomplish all of this using a friendly set of tools which are easy to access.

What you will learn from this Guide
In this user guide, you will learn how to navigate Houdini’s user interface and work with its node-based  
workflow to create 3D animations and visual effects. You will be amazed how much you can accomplish  
and how quickly you will acquire new skills. 
If you already work with 3D animation or VFX software then learning Houdini will be a simple transfer 
of your existing skills. You will learn how to interactively build-up shots using the scene view and shelf tools, 
then work with the resulting nodes and networks to benefit from Houdini’s procedural nature.  
If you are new to the 3D world then Houdini is a great package to start with. This book does go at a healthy 
pace, therefore you should also read about general CG concepts to help you keep up. In the end, you will 
achieve a deeper understanding of how CG works, which will benefit you throughout your career. 
When you finish this book, you can visit www.sidefx.com and find more tutorials.  
Go to Learning > Learning Roadmap for a comprehensive list of available materials.	  	  	 1

DOWNLOAD 
HOUDINI  
FOR FREE
A free learning  
edition of Houdini is  
available for you to  work  
through these lessons. The 
Houdini Apprentice edition 
gives you FREE access to all  
of Houdini’s features with a  
few restrictions such as limited 
render size and a watermark. 
To download Houdini go to  
www.sidefx.com/apprentice 
where you can also get new ver-
sions which are updated regularly.

THE   
APPRENTICE 
PROGRAM
The Apprentice program offers 
much more than just a learning 
edition of Houdini. Artists and 
students can use the Apprentice 
edition to develop projects which 
are non-commercial in nature. 
In addition, Houdini Apprentice 
HD is available which removes 
the watermark and offers higher 
render resolutions. This program 
makes Houdini a great tool for 
developing personal work and 
building up your demo reel.
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Side Effects Software
Houdini is created by Side Effects Software, a 
company which has been developing software since 
3D computer graphics first began playing a role 
in the entertainment industry. Side Effects was the 
first company to put a graphical user interface on a 
procedural modeling system and, over the years, our 
technology has grown and evolved into the Houdini 
used today by top studios around the world. 
For Side Effects, the goal has always been to create 
high quality software for digital artists. Side Effects’ 
award winning solutions have been used in thousands 
of shots in hundreds of feature films. Typically used 
for visual effects, CG art created in Houdini can also 
be found in commercials and video games. 
Houdini’s comprehensive feature set includes model-
ing, rigging, animation, particle effects, dynamics, 
compositing, integrated rendering, and more. Houdini 
is available for the Mac OS X, Linux and Windows 
operating systems.
While Side Effects is best known for its software, 
customers also benefit from fully integrated partner 
relationships that include exceptional customer sup-
port full on-site production services and access to 
daily software updates.
Equally important is Side Effects commitment to the 
growth of skills in the industry as witnessed by the 
Houdini Apprentice program, which gives digital 
artists the chance to build skills and create demo reel 
content in Houdini for free.
Side Effects is driven by a Passion for Production 
and a focus and commitment that keeps the company 
at the forefront of innovation and market leadership in 
the 3D computer graphics industry.
To learn more about Side Effects Software visit the 
company website at www.sidefx.com.

Milestones
1987 - Side Effects releases the world’s first  
procedural animation software called PRISMS.
1996 - Houdini 1 is released providing a next-gener-
ation framework for the procedural technologies first 
introduced in PRISMS.
1998 - Side Effects wins a Technical Achievement 
Award from the Academy of Motion Pictures and Sci-
ence for their work on procedural animation.
1999 - Houdini 4 is the first major 3D animation 
package available for Linux. 
2002 - Side Effects launches the Houdini  
Apprentice Program which provides free 3D  
animation software to artists and students.
2003 - Side Effects wins a Science and Engineer-
ing Award from the Academy of Motion Pictures and 
Science in recognition of their work on procedural 
modeling and animation.
2003 - Houdini Digital Assets introduce the ability 
to extend Houdini’s procedural ideas out into the 
wider production pipeline.
2005 - Houdini is released with integrated Dynam-
ics which make it possible for multiple solvers such 
as Rigid Body, Wire and Cloth to work together.
2007 - Side Effects launches Houdini 9, with a fun, 
easy to learn UI. This new version also adds Fluids.
2007 - Houdini Apprentice HD: The Starving Artist 
Edition is introduced allowing artists and students to 
render watermark-free in HD quality.
2008 Houdini is released for Mac OS X with sup-
port for 64-bit Intel-based Macs.
2009 - Houdini 10 is released with new Pyro FX  
tools and distributed fluid simulations.
2010 - Houdini 11 is released with a new shader 
building workflow, FLIP particle fluids and dynamic 
fracturing tools.

Houdini 
in Production 
There are several different Houdini products avail-
able. Which one you need will depend on your work:
Houdini FX – Perfect for visual effects artists and 
technical directors with its integrated particle and dy-
namics toolset. This version also has all of Houdini’s 
features for a complete toolset.
Houdini – Ideal for modelers, lighters, character rig-
gers and animators.  Houdini also includes features 
such as compositing and motion editing. Scenes and 
Digital Assets created in Houdini FX can be opened 
and rendered with base Houdini and all nodes and 
assets remain intact.
Mantra – All Houdini products come with Mantra 
which is Houdini’s production-proven renderer.
Houdini Batch – Houdini Batch is a non-graphical 
version of Houdini FX which can be deployed on the 
farm for processing simulations, generating output 
files for rendering or managing assets.
To learn how the different Houdini products work in 
production, check out the pipeline diagram on page 6.

personal projects  
and learning
For CG artists who are working on shots to spruce 
up their demo reel, developing new skills, or working 
on personal projects, Side Effects has created the 
Houdini Apprentice program. 
Houdini Apprentice contains virtually all of Houdini 
FX’s features with only a few limitations. It uses a 
special non-commercial file format (.hipnc) and you 
can share files between all of these versions.
Houdini Apprentice – This free version of Houdini 
Apprentice renders with a small unobtrusive render 
watermark and has a limited render resolution of 
720x576. It can be used for learning or to create 
demo reel content. 
Houdini Apprentice HD – Houdini Apprentice HD 
removes the watermark and raises the resolution to 
1920x1080 for animations and unlimited for stills.
Houdini FX Education – This is a full version of 
Houdini FX complete with Mantra and batch tokens. 
It also uses the .hipnc file format so that students can 
work on projects at home using Apprentice.

The World  
of Houdini

For years, CG artists have  
been turning to Houdini to help 
create blockbuster movies and 

award-winning commercials. 
Known as the software used to 
handle the biggest challenges, 

Houdini has grown into a  
well-rounded solution for  

studios big and small.

SELECTED 
FILMOGRAPHY
Houdini has been used by many 
of the top VFX studios to create 
CG for feature films. Here is a 
selected list of movies which in-
clude work created in Houdini:

Avatar
Iron Man 2

Prince of Persia
2012

G.I. Joe: The Rise of Cobra
Terminator Salvation

Up
Cloudy with  

a Chance of Meatballs
Monsters vs. Aliens

Coraline
Watchmen

The Dark Knight
Wall-E

Transformers
The Curious Case  

of Benjamin Button
The Pirates of the  

Caribbean: At World’s End
Superman Returns

The Wild
X-Men: The Last Stand

Spider-Man trilogy
Harry Potter series

Lord of the Rings trilogy
Matrix trilogy 
and more...

Professional Editions Personal Editions

Houdini FX Houdini Apprentice HD Apprentice Education Product

- - -  - Render Watermark

.hip .hip .hipnc .hipnc .hipnc File Format

Unlimited Unlimited 1920x1080 720x576 Unlimited Render Limit

     Modeling

     Animation

     Character

     Lighting

     Mantra Rendering

     Render to Amazon Cloud

  - -  Third Party Rendering

     Compositing

 -    Particles

 -    Dynamics

IN/OUT IN/OUT IN IN IN/OUT FBX	  		  3 	 2	 	



Going 
Procedural

On a daily basis, digital  
artists, like yourself, are being 

asked to create more shots and 
achieve more realistic results 

with tighter deadlines and 
shrinking resources. 

To handle the workload and 
keep focused on the creative 

process, going procedural with 
Houdini will benefit you a  
great deal in production. 

Houdini offers you flexibility and control which  
enhance the way you work creatively and make you 
and your team much more productive. 
In Houdini, everything is procedural which means 
that modeling, character rigging, lighting, rendering 
and visual effects all benefit from this approach. In 
Houdini, each procedural network offers a collec-
tion of nodes which connect together to describe the 
steps needed to accomplish a task. 

Visual effects artists have traditionally gravitated to 
Houdini because this procedural workflow is ideal 
for creating effects with particles and dynamics. For 
other parts of the pipeline, going procedural has ad-
ditional benefits which can be used by studios who 
want higher levels of productivity and by artists who 
want more control over the creative process.

Node-based workflow
In Houdini, every action is stored in a node. Going 
procedural is as easy as placing and connecting, or 
“wiring” these nodes into networks which give you ac-
cess to the complete construction history of a scene.
You can then use tools to add to the network or work 
directly with the nodes to manage the results. You 
can add nodes, delete nodes, by-pass nodes, and 
comment nodes. You can also copy and paste nodes 
or networks between projects. 

You can even create nodes that contain other net-
works inside them then share these custom nodes 
with colleagues. Instead of creating external scripts 
and pipeline tools to manage your work, the networks 
give you a pipeline right inside Houdini.

Rapid Prototyping  
and Reusability
Using Houdini’s procedural approach, artists can 
quickly prototype a shot using low-resolution geom-
etry then swap-in a detailed model for final output. 
Because the network acts like a pipeline, the same 
network can be used in different shots and even dif-
ferent projects while only minor variations are needed 
to produce unique results specific to each situation.
Houdini also makes it easy to share your tools without 
writing any code. Houdini’s re-usable networks can 
be wrapped up quickly and easily into new nodes 
called Houdini Digital Assets. Whether you are 
packaging up a visual effect, a character or a light rig, 
Digital Assets let you hide the network then promote 
key parameters to build an artist friendly interface. 
These assets are, in essence, artist-built plug-ins and 
can be put into production like any other tool. With 
artists and technical directors building day-to-day 
tools this way, on-site programmers can focus on 
much more challenging technical issues.

Managing Complexity  
and Scalability
In a typical CG shot, there are lots of steps involved 
which can result in large networks of nodes. Other 
3D applications generally avoid construction his-
tory or tell you to delete it because their architecture 
would simply bog down as shots get bigger.

Houdini’s node-based approach is designed to mini-
mize and handle complexity and provides you with 
many tools for organizing and managing the net-
works. Instead of deleting history, you learn to use it 
to your advantage and make it an integral part of your 
production process.

Revise Deep  
into Production
By going procedural, all the steps needed to set up a 
shot are represented by the node networks. Making 
changes to any of these nodes will cascade right 
through the network to update your shot. This direct-
ability can be retained deep into production and can 
be used to make last minute creative decisions that 
would be too costly in a traditional CG pipeline.

In this way, Houdini lets you easily respond to direc-
tor feedback by simply inserting an updated asset 
into the pipeline. Houdini Digital Assets also benefit 
from a robust referencing system which lets TDs and 
supervisors manage the assets behind the scenes 
while artists focus on creating. 
This version-less approach to managing assets 
simplifies inter-studio communication and makes sure 
that costly mistakes are not made.

Data Accessibility
As objects move through a typical animation or visual 
effects pipeline they accumulate information which is 
often stored as point or primitive attributes such as 
velocity, capture weights or UV texture coordinates. 
While other 3D applications hide this information 
and attempt to manage it behind the scenes, Houdini 
gives you many tools for working with and managing 
this data. This results in a much more powerful and 
flexible approach that can make a huge difference 
when working in production.

This data flow can be especially effective with objects 
that are animated over time. As a piece of geom-
etry moves and deforms, a procedural network can 
work with this motion and react accordingly. For this 
reason, Houdini is a great tool for making sure that 
effects such as dust, debris, fur, and feathers  
respond to objects in your shot. By keeping the 
flow of data “live,” animation can be revised and 
the effects will update automatically. This reduces 
the manual labor needed to address these kind of 
changes which in turn saves you money.	  		  5 	 4	 	

DO I NEED 
TO WRITE 
CODE TO USE 
HOUDINI?
Definitely not. In fact, 
because of Houdini’s 
node-based workflow, 
you will often be able to create 
results interactively that would 
require lots of code in other 3D 
animation applications.
Houdini is very much an artists 
tool and while it also has a 
technical side that uses scripts 
and expressions, the out-of-box 
tools will let you accomplish 
amazing things. And the nodes 
let you easily go back and make 
changes which mimics how the 
creative process works. 



Houdini in 
the Pipeline

Computer animation and visual 
effects projects involve a num-
ber of steps such as modeling, 
rendering, animation, particles 
and dynamics. Here are some 
of the ways in which Houdini 

can help you in these different 
areas of the pipeline. 

Houdini Products
Houdini FX

VFX Pipeline

Render 
VFX

Rig Characters 
and Props

Model Layout Animate Light Render Composite

Lighting 
VFX

Simulate 
VFX

Animate 
VFX
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Distribute 
Sims

Distribute 
Render

Distribute 
Render

Particles and 
Dynamics

Animation Pipeline

Houdini or Houdini FX
Mantra

Houdini Batch

File Transfer (FBX, BGEO etc...)

Interoperability
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Modeling
Houdini’s modeling tools can be used to 
create characters, sets and props or by 
visual effects artists to give particles and 
fluids shape and form, fracture solids, 
instance geometry and more. 
For traditional modelers, Houdini provides a set of 
tools that work with a wide variety of geometry types. 
For visual effects artists, Houdini’s node-based work-
flow makes it easy to set up complex environments or 
surfaces that are generated on the fly in reaction to 
an underlying effect.

■■ Construction History - As you work, Houdini’s 
node-based workflow keeps track of all your 
modeling actions. Houdini efficiently manages the 
nodes to make sure you are not bogged down as 
you work. This lets you freely revise parameters on 
your nodes, branch off to explore new ideas or set 
up switch nodes to compare topologies.

■■ Build Environments -  To model CG environ-
ments piece by piece can be a daunting task for a 
modeler. With Houdini, you can set up procedural 
networks that build environments out of a smaller 
kit of parts. Once the system is in place, you can 
easily add randomness, paint specific features 
such as height and scale, and eventually grow the 
solution to any size. 

■■ Clean Geometry - Building a model is one 
thing. Building a model that animates and renders 
properly is a different matter altogether. Houdini 
give you low-level access to every aspect of your 
geometry and provides procedural techniques for 
making your geometry production-ready.

Modeling tools are available in:  
Houdini and Houdini FX.

Animation
Whether you are bringing characters 
to life or creating high-powered visual 
effects, the ability to freely animate 
anything and everything is critical. 
Houdini not only lets you animate any 
parameter, but with transition nodes such as switch 
and blend you can easily animate back and forth 
between completely different networks. The result-
ing motion can then be processed through Houdini’s 
procedural motion editing system called CHOPs for 
even greater control.

■■ Animator-Friendly Workflow - Animators can 
easily set keyframes on selected objects then edit the 
results in either the timeline, channel editor or dope 
sheet. Channel groups can be created and pinned 
to make it easy to set many keyframes on multiple 
parameters to block out motion. Houdini has other an-
imator-friendly tools such as Heads up display (HUD) 
handles that provide quick access to key parameters.

■■ Flipbook Blocking - Houdini’s flipbook can be 
set up to only play back frames where your char-
acter has been keyframed. The flipbook plays back 
in real-time and holds the frames based on their 
proper timing. Animators can then quickly move 
the frames around in the flipbook to adjust the tim-
ing then export the results back into the 3D scene. 
A real time-saver on the production floor.

■■ Advanced Motion-Editing Tools - Houdini’s 
procedural motion editing environment called 
CHOPs lets you either build up motion using a 
node-based workflow or import keyframed  
motion, run it through motion filters, then send  
the results back to its original parameters. Get 
quick access to these tools using the Motion FX 
menu to discover a completely new way of  
manipulating motion-data.

Animation tools are available in:  
Houdini and Houdini FX.

As you learn more about Houdini’s procedural ap-
proach, you will discover the many benefits it offers 
for CG artists working in production. Whether you are 
working on your own, with a small team of artists or a 
studio with hundreds, a procedural approach creates 
a clean flow of data which supports the exploration of 
ideas and changes made by the director.
Houdini is best known as a visual effects package,  
although it has been used by some studios for all 
parts of the pipeline. To help you map out the  
possibilities, the following diagram outlines all  
the different areas where Houdini can be used. 
The production pipeline mapped out here offers a 
generic picture which might apply to a large pipeline 
used by a big studio or a simple pipeline used by a 
smaller team. This is because Houdini’s procedural 
approach offers a viable pipeline solution for indi-
vidual artists which scales very well no matter how 
big your team grows.

Of course, the steps shown here would change de-
pending on whether you are creating visual effects, 
CG animations, commercials or videos games. In 
general though, these pipelines share certain com-
mon threads which are represented by the steps as 
outlined. Any differences are easily accounted for in 
Houdini as you customize your workflow to suit the 
particular needs of your project.
Houdini can play an important role in a larger 
pipeline because it has the ability to open up scenes 
created in Houdini FX allowing you to animate, light 
and render the existing nodes. 
If visual effects in Houdini FX are packaged up as 
Digital Assets then you can even have junior FX 
artists using them to finish up shots in base Houdini. 
You can also exchange files with other apps using 
formats such as FBX. This ability to pick the right 
tool for the right job makes a Houdini-based pipeline 
an effective solution. 

PIPELINE  
DIAGRAM
This diagram 
shows how all of the  
Houdini products fit into a  
typical CG pipeline. 
While Houdini FX can be used 
for all stages, many parts of the 
pipeline are a better fit  
for Houdini’s more affordable 
feature set.

The Wire Man 
Mark Wainwright 

Bolex 
Lisa Kelly



Character Rigging
From cartoon characters that squash 
and stretch to hyper-realistic digital 
creatures, character rigs continue to get 
more and more sophisticated to meet the 
growing expectations of audiences. Houdini provides 
a robust character solution that can be used as part 
of a visual effect or as a larger animation pipeline. 
Houdini’s node-based approach fits perfectly with 
working methodology of a typical rigging Technical 
Director without relying on lots of scripting.

■■ Digital Assets - Characters in Houdini are 
created as Digital Assets that encapsulate all the 
bones, geometry, deformations, facial poses and 
even materials. You can then reliably reference 
your characters into multiple scenes and seam-
lessly edit and update them as needed.

■■ Production-Ready Auto Rig Tools - Created 
by animators, the Auto Rig tools make it easy to rig 
up any character. Set up an animation rig in less 
than an hour with proxy geometry and start animat-
ing right away. Then capture your actual surface 
to a separate deform rig that can be plugged in 
once you have painted capture weights. Biped and 
quadruped setups are ready to go out-of-the-box 
while custom auto rigs can be quickly built using a 
wide variety of both human and animal body parts.

■■ Interactive Muscles And Skin - Adding realis-
tic muscles and skin to your characters has never 
been easier. Build up your underlying muscula-
ture using metaball-based tools then capture the 
metaballs to drive the character’s skin. This unique 
system provides interactive feedback that does 
not require simulation even for systems built using 
jiggle and skin sliding.

Character rigging tools are available in: 
Houdini and Houdini FX.

Particles
From dust to debris to flocks of birds, 
particles offer a strong foundation on 
which you can build any effect. Houdini 
is famous for its node-based particle 
workflow that lets you define a set of rules using 
interactive tools.

■■ Total Control - To build up complex particle sys-
tems, Houdini gives you access to a rules-based 
approach that offers unlimited control. Define the 
behavior of the system for each individual particle 
using a network of nodes that set up a series of 
operations and conditions. By defining the rules, 
you can create particle simulations that behave 
the way you need them to no matter how many 
particles are involved.

■■ Full Integration - The most impressive particle 
effects involve interaction with the other parts of 
your scene. In Houdini, particles can react to and 
influence geometry, dynamics, and even  
materials. This creates a shot that is alive with 
interconnections that would be impossible to  
manage with keyframes alone.

■■ Rendering Particles - While particles are  
just points in space, their final rendered look  
will be quite different. From sprites to  
volumetrics to instanced geometry, there are  
a number of ways in Houdini for you to make  
your particles more realistic.

Particle tools are available in:  
Houdini FX.

Dynamics
Create realistic motion that meets the 
creative needs of your director using 
Houdini’s integrated dynamics tools. 
Houdini’s dynamics architecture lets dif-
ferent solvers talk to each other, so you 
can simulate using any combination of Rigid  
Body, Fluid, Cloth and Wire solvers to create 
boundary-busting effects.

■■ Solvers That Work Together - When working 
with dynamics, it is critical that you can control 
both what goes into a simulation and what comes 
out. Rigid Body, Fluid, Cloth and Wire dynamics 
all work together to create highly sophisticated 
simulations that you can easily integrate into your 
existing effects pipeline.

■■ Fire, Smoke And Water - To create natural 
looking fluid effects, you can work with volume-
based or particle-based fluid simulations in 
Houdini. Apply a variety of forces such as surface 
tension, viscosity, visco-elasticity, vorticles and 
fuel to control the results. Particle fluids can be 
surfaced at the geometry level to produce high 
quality splashes.

■■ Smashing and Tearing - Houdini’s Rigid Body 
Dynamics solver lets you create highly complex 
simulations of large data sets. The solver works 
with various forces, constraints and collisions and 
gives you complete control over all aspects of 
the simulation. A unique and powerful feature is 
Houdini’s Voronoi-based dynamic fracturing tools 
which will break up a model based on the impacts 
which occur during a simulation.

■■ Distributed Fluid Sims - Unique slicing of 
simulations to distribute calculations on the farm. 
These sims are also fully multi-threaded. 

Dynamic tools are available in:  
Houdini FX.

Lighting
Houdini’s lighting workflow provides a 
flexible and powerful environment for 
managing lights, building shaders and 
defining the look of a shot. Light and 
material shaders are created using Houdini’s proce-
dural node-based shader builder featuring dozens of 
shader operations.

■■ Control Lights Across Many Shots -  
Senior lighters can set up lighting for a family of 
shots then bundle them up into light rigs that are 
distributed as Houdini Digital Assets. This ensures 
that each shot has a common starting point while 
parameters can be tweaked on a shot by shot 
basis to perfect the look.

■■ Material Palette - Houdini now includes a mate-
rial workflow that begins in the Material Palette 
where you have access to a rich gallery of materi-
als which can be applied as is or edited using the 
shader builder. To create different looks for your 
objects, you can override material properties on a 
per object basis.

■■ Building Shaders and Materials - Whether 
you use Houdini’s Mantra renderer or Render-
Man, shaders can be created using the interactive 
shader builder. Connect nodes to define the look 
of the shader then bundle up one or more shaders 
into Materials. You can even set up both Mantra 
and RenderMan shaders in a material then use 
a switch node to trigger when the appropriate 
renderer is used.

Lighting tools are available in: 
Houdini and Houdini FX.

Smashup 
James Roberts

Rocket 
Keith Acheson
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Lighthouse 
Steve Tucker

Sea Dragon 
Sergio Caires



Rendering
At the back-end of any CG project  
is where you render all your lights,  
geometry, and effects. With Houdini, 
you can rely on a robust built-in 
rendering solution called Mantra or full support for 
a wide variety of third party renderers. Whatever 
route you choose, Houdini is the ideal environment 
for bringing together your render layers and reliably 
feeding the farm.

■■ Mantra - More and more studios are discovering 
the performance benefits of a Mantra render pipe-
line. With a strong shading language behind  
it and the ability to choose between micropolygon, 
raytracing or physically-based rendering, you  
will quickly learn how Mantra can benefit you. 
Unlimited Mantra tokens with either Houdini  
or Houdini FX makes this an even more attractive 
option.

■■ RenderMan Support - With Houdini, you will 
enjoy a tightly integrated interface to Pixar’s Ren-
derMan® and RenderMan compliant renderer such 
as 3Delight which includes a node-based Render-
Man shader builder and support for test renders  
in the 3D scene view.

■■ All Renderers Welcome - Houdini also pro-
vides integrated support for other thrid party ren-
derers such as mental ray™ and Maxwell™. With 
Houdini’s new Python support, you can easily write 
your own hooks for whichever renderer you prefer.

Rendering tools are available in: 
Houdini and Houdini FX.

Compositing
While you likely rely on an existing team 
of compositors to layer effects onto live 
action plates or tweak render passes, it 
does not hurt to do a little compositing 
as part of the lighting and rendering of your shots. 
With node-based compositors offering the most 
robust solution when working in production, Houdini’s 
approach carries over well to this area of production.

■■ Render Pass Support - When you render dif-
ferent passes, you need a quick way of verifying 
that everything worked out fine. Houdini lets you 
link together render output nodes with compositing 
output nodes that render together as a network. 
This gives you both your individual passes and the 
final composite with the click of a button.

■■ Perfect for Lighters - To speed up the deci-
sion-making process as you light a shot, you can 
choose to render out high dynamic range images 
and set light contributions in the compositor. This 
is a much more interactive process and it makes 
it easier to involve a director in this critical phase 
of a project. If you render out surface normal 
information you can also set up new lights in the 
compositor without re-rendering the shot.

■■ Production-ready - The compositing tools are 
fully multi-threaded and built on a modern tile-
based architecture boosted by access to the GPU.

Compositing tools are available in: 
Houdini and Houdini FX.

Scripting
Scripting and programming can play 
an important role in setting up ad-
vanced production pipelines and tools. 
With Houdini’s node-based workflow 
and Digital Asset technology, many tasks normally 
reserved for the programming team can now be 
handled by artists. Beyond that there are a number of 
robust scripting and programming tools available in 
Houdini with Python playing a key role.

■■ HScript Expressions - Houdini’s own expres-
sion language used to create channels references 
and write simple expressions. In many cases this 
work can be handled more efficiently with Python. 

■■ Integrated Python Support - Houdini includes 
an object-oriented Python API which provides 
low-level access to everything you need to script. 
Easily integrate Houdini into your existing pipeline 
with full access to Python libraries and build cus-
tom UI widgets that work directly in Houdini.

■■ The Power Of VEX - VEX is a high perfor-
mance parallel language for processing large 
amounts of data. With a syntax similar to C, VEX is 
easy to learn for anyone with a coding background. 
VEX is used to write custom nodes for Houdini and 
to create shaders. Houdini includes a node-based 
interface for creating VEX code.

■■ FREE Houdini Development Kit - The HDK 
is a C++ toolkit for developing plugins for Houdini 
and Mantra that gives you access to the same 
interface to Houdini that Side Effects Developers 
use. You can even use the HDK if you work with 
Houdini Apprentice.

Scripting tools are available in: 
Houdini and Houdini FX.

Interoperability
If you are already working in an es-
tablished pipeline then you may want 
to model, animate or light your shot 
in another application. In these cases, 
you can pass data from those apps back and forth to 
Houdini using exchange formats such as FBX. 
Even in an all Houdini-based pipeline, geometry files 
are often saved out at the end of one stage then ref-
erenced into the next. This works well since Houdini 
can keep a live connection to the file on disk and 
update quickly when those files are changed.

■■ Geometry -  Houdini has a built-in geometry 
format called .bgeo which support geometry 
sequences, point data and more. Houdini is also 
part of the open source Alembic initiative being 
developed by Sony Pictures Imageworks and ILM 
which is also about outputting geometry files.

■■ FBX -  This interchange format gives you a meth-
od for exchanging whole scenes including rigging 
info, lights, cameras and more. You can import and 
export to this format from within Houdini.

■■ Collada - Originally a game-focused solution, 
Houdini can import files using this format.

■■ OpenEXR - Rendered images with multiple 
channels can be exported to this format for us-
ing in a compositor. This format is another open 
source project sponsored by ILM.

Interoperability tools are available in: 
Houdini and Houdini FX.

Leopard 
Keith Acheson

Shatter 
Steve Tucker

Pororoca 
Scott Pagano

Chrome 
James Roberts
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COLLAPSING 
PANES AND 
TOOLBARS
Both panes and tool 
bars can be collapsed 
and expanded by clicking on the 
arrows found in their UI. Whole 
panes can be collapsed to the 
left or right and you can flip the 
contents using the center grip. 
These options let you focus on 
certain panes by hiding others 
using a single click of the mouse.

The Houdini 
Workspace

Houdini offers a familiar user 
interface experience for CG 

artists which include a variety of 
tools which work interactively in 

the 3D scene view. The work-
space is highly customizable 
and can be set up to support 

different ways of working.

Houdini gives artists many different ways to view the 
bits and pieces that make up a 3D scene. From the 
Scene view where you look through a camera at 
your geometry to the Network view where you man-
age the procedural nodes and networks, you will find 
many different ways to make creative decisions while 
making sure each shot works at a technical level. 

Shelf Tools
At the top of the workspace, you will find two shelves 
filled with options for creating and manipulating ob-
jects, geometry, cameras, lights and effects.  

These tools are designed to work in the scene view 
and either involve some sort of scene view interac-
tion or require one or more selected objects to work 
properly. Once you have used one of these tools, you 
will create one or more nodes which you can then 
refine in the Parameter and Network panes. 

While the same nodes can be placed down directly in 
the Network view, the tool shelves will often put down 
several nodes using the best configurations for use in 
production. It is therefore a good idea to learn what 
the shelf tools can do for you then use the Network 
view to make changes and explore other options.

View Tools
Here are some of the hotkey combinations available 
while viewing. You can skip the spacebar if you are 
actually in the View tool:

■■ Tumble 	 Spacebar - LMB
■■ Pan	 Spacebar - MMB
■■ Dolly	 Spacebar - RMB

In some cases, you will want to home in to get your 
bearings. There are some hotkeys for that as well:

■■ Home Grid	 Spacebar -h
■■ Home All 	 Spacebar - a
■■ Home Selected	 Spacebar - g

You can find the View tool in the toolbar.  When you 
use the spacebar, you temporarily evoke the view tool 
without interrupting the use of your current tool. 

Pane Tabs - The tabs let you  
create and organize multiple panes.

Operation Controls - Use the 
Handle tool with this bar to access 
parameters from your selected node.

Parameter Pane - This pane lets 
you set values, add expressions 
and keyframe selected nodes.

Display Bar - These toggles let 
you display scene view information 
such as normals and UVs.

Scene View - Visualize your work 
and use handles to manipulate 
objects interactively in your scene.

Network Pane - View and manage 
networks of nodes to work with the 
underlying structure of your scene.

Timeline- Set the current time and 
edit keyframes on selected nodes.

Tool Shelf - The shelf tools let  
you work interactively with objects 
and geometry in the scene view.

Selection Modes - These modes 
let you focus on scene, geometry, 
particle or dynamic objects.

Transform Tools - Select, Move, 
Rotate or Scale or use the Handle 
tool for node-specific controls.

Snapping Tools - Turn on Grid, 
Primitive, Point or Multi-snapping.

Viewing - Use the View tool to 
Tumble, Pan and Dolly or Render 
Region to render in the scene view.

Output Tools - You can render 
or flipbook your scene with these 
tools to evaluate it better.

This can be quite useful when you are selecting or 
manipulating in a view and need to quickly change 
your point of view. If you want to focus on viewing 
then you can press Escape to go to the view tool.

Context sensitive 
Right Mouse Menus
As you work with Houdini, you will find that there are 
many right mouse button menus available to you de-
pending on your context. If you RMB on geometry, you 
will get a different menu than if you RMB on a handle 
or in empty space. You can RMB on pane tabs, tools, 
tool shelves and on nodes in the network editor. 
In the scene view, you will also get a different RMB 
menu depending on which tool you are working with. 
For instance the View tool and the Select tool have 
different options available.

Display Menus
The way in which objects appear in the scene view 
can be set up using the following three menus:

Shading Menu
  Object Display Menu
                         Views Menu

Shading Menu - This menu lets you choose from 
options such as wireframe, flat shaded, smooth shaded 
or smooth wire shaded. For more options, click on Dis-
play options button at the bottom of the Display bar. 
Object Display Menu - As you dive into various 
networks, this menu sets whether you can hide other 
objects, view them all or see them ghosted.
Views Menu - This menu lets you split your scene 
view into various views such as perspective or ortho-
graphic views and has an option for syncing up all the 
orthographic views.

Display Bar
At the right side of the scene view, the display bar 
gives you a number of toggles which can help you 
work more effectively. From grids, to viewport 
shadows to point numbers and normals, these display 
options can be very helpful in production.

■■ Display Options 	 d

Panes and Pane Tabs
The Houdini workspace is organized into panes which 
offer you different ways to view and edit the bits and 
pieces that go into building up a shot.
For organizing your scene, you can use the Tree 
View, Take List or Parameter Spreadsheet. To 
work at a command-line level, you could use the 
Textport or Python Shell panes.
Animators will often call on the Channel Editor and 
Channel List panes and the Motion View pane 
offers access to channel operators. For Lighters, the 
Material Palette, Light linker and the Composite 
View panes will come into play.

customize Your  
workspace
As you open up tabs, add dividers and organize your 
pane tabs, you start to set up your own workspace. To 
save this layout, you can go to the Window > Desk-
top menu where you can access saved desktops, save 
your own and manage them as you work.
You can also choose a color scheme for your workspace. 
Select Edit > Color Settings to bring up the option 
window then you can choose from the default Houdini 
Light or Houdini Pro or Houdini Dark. You can also 
choose to download user-created color schemes.

Expand Bar

Collapse to Left

Flip Panes

Collapse to Right

Collapse Bar
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Nodes and 
Networks

With Houdini’s node-based 
workflow at the heart of its 

procedural approach, the  
ability to work with these nodes 

and networks becomes very 
important to using it effectively. 

Luckily there are lots of artist 
friendly tools for building up 

and managing nodes.

As you use tools in Houdini, nodes are created and 
wired with other nodes. The resulting networks offer 
a history of your actions while providing a simple 
way to use this flow of information to make changes 
and refine your work. While it is possible to focus all 
your effort on the scene view, learning how to work 
effectively with the node networks will give you more 
flexibility in production. 

Network Paths
Nodes are organized hierarchically with some nodes 
nested in other nodes known as network managers or 
subnetworks. To help you manage these hierarchies, a 
browser-like path is available at the top of most panes.

Pin Path

  Drag Target to another Pane

Back/Forward Button

       Path Hierarchy

You can use this path to navigate up and down this 
hierarchy or to other networks you have been working 

with. By default, the path changes as you make selec-
tions in the scene view although you can pin down a 
path to keep it focused. You can also drag the target 
icon to another pane to change its path. 

Network Types
Houdini includes different kinds of nodes which 
each work in their own context. The network type is 
highlighted in the network view and can be used to 
determine where you are in Houdini.

■■ Scene	 Objects 	 OBJ
■■ Geometry	 Surface Operators	 SOPs
■■ Shaders	 Shader Operators 	 SHOPs
■■ Motion	 Channel Operators	 CHOPs
■■ VEX Builder	 VEX Operators	 VOPs
■■ Render Outputs	 Render Operators	 ROPs
■■ Particles	 Particle Operators	 POPs
■■ Dynamics	 Dynamic Operators	 DOPs
■■ Compositing	 Compositing Operators	 COPs

While the different types of nodes are similar in 
how they are wired together, they each have unique 
capabilities which can affect how they can be used. It 
is important to learn how each one works.

Align Tools - These tools let you 
organize the look of your network.

Network Type - Shows which 
network type you are working in.

Node - This represents an opera-
tion that contributes to the final 
output of the network.

Connector - The connecting lines 
show how your nodes are linked to-
gether and how the data is flowing.

Display Flag - This flag and the 
small circle show which node is 
displayed in the Scene view.

Render Flag - This flag and the 
large circle indicate a render node 
even if another node is displayed. 

Network Path - The path leading 
to the current network level is dis-
played here. You can also use this 
bar to navigate to other networks.

Network Background - You can 
add an image or set up a grid to 
help you organize your nodes.

Sticky - Add notes to help other 
artists read your network or to offer 
ideas for their networks.

Network Box - Group together 
related nodes then quickly collapse 
and expand them.

Node Gallery - Drag these nodes 
over to add them to your network. 
Use the filter at the bottom to 
quickly find the node you need.

If you encounter a seasoned Houdini user, you will of-
ten hear them talk of POPs, SOPs and DOPs. As you 
can see ,each of these refers to a specific network 
type and has become the secret language of Houdini 
users around the world.

navigating  
Networks
To jump between network types there are a number 
of different approaches you can take. Some of these 
happen naturally as you work with objects in the 
scene view and others offer shortcuts which can get 
you to another network more quickly. 
Selection Modes - As you select in the scene view, 
the network editor jumps to the location of the selec-
tion. Different selection modes will in turn take you to 
different network types as you make a selection.
Network path - You can LMB-click on the network 
path to go back up the path or RMB-click to access 
other parallel networks.
Hotkeys - Here are a few hotkeys which help you 
navigate up and down as you work with objects. 
These hotkeys work with selected nodes.

■■ Dive in 	 i
■■ Jump up 	 u
■■ Go to Geometry	 F8

Jump to Menu - If you RMB-click on geometry, 
then you can use the Jump to submenu to go to  
networks which contain nodes related to the  
geometry. This could be a material, particle  
network or dynamic network.

working in the  
Network editor
In the network pane, you will need to pan and zoom 
around to work with the complete network. Here are 
the key combinations for these actions.

■■ Select Nodes 	 LMB
■■ Pan 	 MMB
■■ Zoom	 RMB

Here are some other ways of interacting with nodes 
and connections in the network pane.

■■ Connect Node 	 LMB on output then on input
■■ Insert Node 	 LMB drag onto connector
■■ Disconnect Node 	 LMB then Jiggle node
■■ Disconnect Node	 RMB-menu on connector

Node Flags
Each of the nodes seen in the network view have vari-
ous flags which determine if it is displayed, locked 
or bypassed. You will work with these flags as you 
manage your networks.

Template Flag
  Display/Render Flag

Bypass Flag 
       Lock Flag

Display Flag - The display flag offers a way for you 
to choose which node in your network is used as the 
output for that network. 
Render Flag - This flag sets which node will be out-
put for rendering. You can set this separately from the 
Display flag by Alt[opt]-clicking on the Display flag. 
Bypass Flag - This flag means that this node is 
ignored when the network is cooked. 
Lock Flag - This caches a network at the locked 
node and all changes to nodes earlier in the chain are 
ignored when the network is cooked. 

Node Galleries
The galleries offer quick access to nodes that you 
want to add to your network directly. The galleries 
contain those nodes used the most in day-to-day 
work while the tab key has all the nodes.
You can create your own galleries using the Win-
dows > Gallery Manager and you can add items 
to your galleries by RMB-clicking on a node then 
choosing Save to Gallery...	  		  15 	 14	 	

WHAT DOES 
IT MEAN TO 
COOK NODES 
IN HOUDINI?
The cooking of a node 
refers to the flow of data 
through a network and 
the various calculations needed 
to show the final output. 
Houdini is very smart about 
when it cooks a network, mak-
ing it possible for you to keep 
the nodes around as you work. 
When the results of a network 
are being displayed Houdini 
looks for “dirty” nodes then 
re-cooks. Otherwise the network 
doesn’t re-cook and you can 
move ahead more quickly.
You can also select Windows 
> Performance Monitor to 
bring up a window which lets 
you evaluate the cooking of your 
networks and then figure out 
which nodes are slowing you 
down. You can then change your 
network and explore ways of 
making things go faster.

 



Select and 
Transform 

Interacting with 3D scenes 
involves the selection and 

manipulation of many different 
elements. You should therefore 

become familiar with how  
Houdini’s selection and  

transform tools work.   

In Houdini, you can either  
select objects, faces and points 

in the scene view or the node 
view, then make adjustments 

using handles. 

One of the first things an artist does when faced with 
a new application is to dive into the software. One of 
the first question which arises is to “how do I select 
and edit objects.” In the case of 3D geometry, this 
often brings up the question of “how do I transform 
objects,” then “how do I select points and faces to 
begin reshaping the object.” 
Houdini has a number of different ways of making 
selections in the scene view that work with objects, 
geometry, particles and dynamics. Another way of 
working is to select nodes which can also give you 
access to handles and allow you to edit your scene. 
Both approaches work well and offer you different 
ways of getting the job done.
You will sometimes want to select and work with 
objects while other times you will want to dive in and 
work with the underlying networks of nodes. As much 
as possible, you will want to make these selections in 
the Scene view. 

Select tool
The select tool lets you focus on making selections 
therefore it doesn’t have any manipulation handles. 
You can use the selection modes to decide what you 
want to select then pick away in the Scene view.

■■  Select	 s

Transform Tools
The transform tools give you handles that you can use 
to manipulate objects or reshape geometry. You can 
also make new selections while using these tools then 
continue to transform using the new selection.

■■  Move	 t
■■  Rotate	 r
■■  Scale	 e

When you transform objects, the parameters at the 
object level are updated to reflect your changes. If 
you have geometry selected then an Edit node is 
placed down to accept your transformations. In both 
cases, you can focus on the Scene view and the 
handle manipulations will change the parameters.

Selection Modes
By using selection modes, you can access geometry, 
particles and dynamics and your network will jump to 
the appropriate location without you navigating the 
node hierarchies. 
Objects - The object network level is where you 
work with an object’s transforms. By default all object 
types are selectable but you can filter down the list 
by RMB-clicking on the Selection Mode icon.
If you are using the Select, Move, Rotate, Scale 
or Handles tools, the following hotkey will bring you 
back to the Object level:

■■  Objects 	 1
Geometry - You can use any of the following hotkeys 
to jump into geometry mode with the chosen compo-
nents available for selection.

■■  Points 	 2
■■  Edges 	 3
■■  Faces 	 4
■■  Vertices 	 5

Only one of the geometry selection modes can be 
active at a time. You can use these to select specific 
parts of your geometry then use modeling tools to 
edit its shape. Important: these hotkeys do not work 
when you are in the View tool.
To jump up and down from the Object to Geometry 
levels, you can also use the following hotkeys. These 
work with your selected objects and take you to 
whichever geometry type was last used. 

■■ Toggle Objects/Geometry 	 F8
■■ Dive into the Geometry level 	 i
■■ Dive back up to the Object level 	 u

Particles and Dynamics - These selection modes 
let you find Objects and points that are part of a 
simulated effect. When you select the item in ques-
tion then unpinned networks will jump to the selected 
network level.

■■  Particles 	 6
■■  Dynamics 	 7

handle tool
When you are working with nodes that are not at the 
object level, you will want to work with the specific 
handles associated with that node. This is where 
the Handle tool comes in. It looks at the currently 
selected node and makes the appropriate handles 
appear. 

■■  Handle	 Enter
After using a tool from the tool shelf, you often end 
up in the Handle tool where you can work interac-
tively using the provided handle. 

View tool
If you want to evaluate your geometry quickly without 
losing your current selection then you can go into the 
View tool. This will take away any selection highlights 
and let you visualize the results. When you return to 
one of the other tools then your selection will appear 
highlighted on the geometry.

■■  View	 Escape

Selecting nodes
Nodes play an important role in organizing and build-
ing up a 3D scene in Houdini. They provide artists 
with a look “under-the-hood” and can be used to 
organize and manage a scene. They also offer a quick 
way to select a specific part of an objects history and 
make changes in the Parameter pane.
Once you have a node selected, you can press the 
Enter key in the Scene view to go into the Handle 
tool which will bring up a handle to let you adjust 
certain parameters for the selected node. Other 
parameters can be changed in the Parameter pane as 
long as the node is selected.
In geometry networks, when you select a node in the 
chain that is not the display node, you get a wire-
frame display of the geometry at that point. You can 
then use the handle to manipulate this intermediate 
node. In addition, the Select tool will let you select 
from the intermediate node, and any tools you apply 
will insert a node at that point in the chain.

SELECTIONS - Making selections 
and transforming is a workflow you 
will perform on a regular basis in the 
Scene view. Here are the main tools 
you will use as you work interactively.

Edge Selection - In this image, edge 
selection has been used to get an 
edge loop around the character’s eye. 
If you were to change to point selec-
tion then the selection would convert.

Scale Tool - The Scale tools is being 
use to manipulate the selection. You 
will work with the handle in the view.

Handle - This handle lets you scale 
in all axes using the arrows, two axes 
using the outer edges and one axis 
using the lines under the arrows. 
RMB-click on the Handle to access 
the handle options.

Shading Options - The shading 
options determine what you see in 
the Scene view. In this case, the 
geometry uses basic shading.

Display Filter - This filter lets you 
turn off things you don’t need such 
as bones, null objects, lights or 
cameras to let you focus.

Display Options - While the 
selection modes show you edges or 
points when you have nothing se-
lected, you need to turn on Display 
options if you want to see these all 
the time. 

RMB-Menu - This menu gives you 
access to selection options such as 
edge loops or growing and shrink-
ing your selection. 

In this network, the Handle tool 
uses the polyextrude1 node’s handle 
and shows a wireframe of what the 
model looks like at that stage while 
the subdivided geometry is shaded.
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SELECTION 
MODE 
OPTIONS
Each of the selection 
modes comes with  
options which let you alter how 
you interact with your scene. 
You can access these options by 
either  LMB or RMB-clicking 
on each mode’s icon.



Time and 
Motion

Animation involves changes 
happening over time. Whether 
we are talking about the posi-
tion of an object or its overall 

shape, if moving forward in time 
creates a visible change then 

you have yourself an animation.

Houdini has all the key tools  
for a keyframe-based workflow  

in addition to a procedural 
node-based workflow called 

CHOPs for more advanced ma-
nipulation of time and motion.

The Timeline
At the bottom of Houdini’s main workspace is the 
Timeline which lets you see your frame range and set 
your current time. Houdini measures time in frames 
with a default frame rate of 24 frames per second. 
The Timeline can also be used to edit keyframes.
At the left are the playback controls. Here are some 
hotkeys for quickly setting up playback and moving 
through time. 

■■ Play Forward	 
■■ Play Back	 
■■ Next Frame	 
■■ Previous Frame	 
■■ First Frame	 Ctrl + 
■■ Next Scoped Key	 Ctrl + 
■■ Previous Scoped Key	 Ctrl + 

You can also RMB-click on the frame range in the 
timeline to access options such as Cut, Copy and 
Paste of keys along with special pasting such as 
Replace, Cycle, Repeat and Stretch. All these op-
tions also have their own hotkeys which you can find 
on the menu. You can accomplish a lot working in the 
Timeline before moving to the Channel editor.

Setting Keyframes
To animate, keyframes are set whenever you want to 
set a specific parameter value at a specific point in 
time. As these keyframe values change, the objects 
in your scene will become animated. You can then 
define animation channels to create the in-between 
shape for each animation curve.

Here are a few main hotkeys used to set keyframes 
on your objects while working in the scene view:

■■ Set Keyframe	 k
■■ Toggle AutoKey	 Alt + k
■■ Key Handle	 Ctrl + k
■■ Key Translate	 Shift + t
■■ Key Rotate	 Shift + r
■■ Key Scale	 Shift + e

You can also set keyframes in the parameter pane by 
RMB-clicking on a parameter and selecting Chan-
nels and Keyframes > Set Keyframe. This lets you 
set keyframes one parameter at a time.

Scoped Channels
When you set a keyframe or look at animation curves 
in the channel editor, you are generally working with 
what are called scoped channels with a channel 
being another name for a parameter. While the scop-
ing process happens automatically as you work, it is 
useful to understand it as you begin animating.
If you select an object then its channels are scoped 
and any existing keyframes loaded into the timeline or 
channel editor. If there aren’t any keys then the chan-
nels wait for you to press the k key.
The Channel List can be used to keep tabs on 
which channels are currently scoped. You can set up 
channel groups which offers another way of scoping 
channels and lets you pin down groups of channels so 
that they stay scoped even if you deselect an object. 
You will want this pane visible if you are setting keys.

The channel editor
Scoped channels are loaded into the channel edi-
tor where they are represented as keyframes and 
animation curves. The keyframes can be selected and 
edited and the curves can be shaped using tangent 
handles. The curves define the motion in-between the 
keyframes and play a key role in defining the quality 
of the motion. 
While working with channels you can change which 
keys you are viewing using these hotkeys:

■■ Pan 	 Spacebar - MMB
■■ Zoom	 Spacebar - RMB

Flipbook Previews	
As you animate your scene, you will want to 
preview the results. The Flipbook tool found 
on the toolbar on the left side of the Scene 

view lets you capture frames from the viewport then 
playback the results as a movie.
You can also use Flipbook blocking to capture 
only frames that have keyframes set, then watch the 
frames play back with the proper timing. You can then 
edit the timing of the frames right in the Flipbook.

Channel Operators  
and Motion FX
While keyframes and animation curves are stored 
in the parameters of your nodes, you can also use 
channel operators (CHOPs) for a more complete 
node-based approach to working with motion. 
The easiest way to create a channel operator is using 
Motion FX which can be found when you RMB-click 
on a parameter and select from the Motion Effects 
sub-menu. You can also apply these effects to channel 
groups using the Channel List or the Timeline.
Motion FX can be applied to keyframed motion which 
is extracted and stored in a Channel CHOP. You 
can then apply effects such as cycle, noise, smooth, 
limit or lag to the existing motion. 
These effects are added using procedural nodes and 
offer a lot of flexibility as you refine your solution. On 
the Animation shelf, you have tools which let you have 
one parameter either lag or jiggle behind another. 
This non-linear approach to working with motion 
offers a different way of working that can be very 
flexible and powerful in production.

Current Time - The current 
time is shown in the field 
and on the black marker 
in the frame range. The 
marker can be used to scrub 
through the timeline. 

Frame Range - The overall 
range is defined by the Ani-
mation controls button at the 
far left. Then the range can 
be reduced using the handles 
at the bottom of the range.

Edit Keys - As you set keys, 
your scoped channels are 
shown in the timeline. Press 
the shift key to select keys 
with the LMB and then edit 
the keys with the MMB.

Auto Key - The Auto Key 
button will automatically set 
keyframes when you change 
a parameter value. This 
works well for a straight-
ahead animation style.

CHANNEL EDITOR - This panel 
is where you refine your animation 
channels and work directly with 
keyframes and curves.

Editor Options - This editor can 
be shown as a graph, a dope sheet 
or a table. You can choose the type 
of editor which is most appropriate.

Channel Groups - This area of the 
graph shows you channel groups 
which make it easier to select and 
pin your scoped channels.

Scoped Channels - Channels 
that have been scoped show up in 
this area. You can then select the 
names of channels you want to see 
in the graph.

TIMELINE - The timeline is 
where you scrub through time and 
create and edit keyframes. The 
timeline is for making quick edits, 
while the Channel editor is for 
more comprehensive refinements.

Playback Controls - These  
controls let you quickly play,  
pause, and move to next key. 

Selected Key - Move the key in 
time using the vertical bar and edit 
its value using the box.

Tangent Handles - They define 
the tangents coming in and out of a 
keyframe and they help you shape 
the surrounding animation curves.

Curve - The animation curves 
define the motion in-between the 
keyframes, which defines the qual-
ity of the motion. 

Curve Functions - They let you 
change the shape of the in-between 
curves and can determine if you 
are speeding up or slowing down.
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ACCESSING 
MOTION FX
The Motion FX menu is 
available when you RMB-
click on a parameter. This 
will assign a CHOP to that 
parameter then show you 
the motion view and a float-
ing parameter pane for you 
to edit the node.
 



Lighting and 
Rendering

Lighting and rendering  
a shot involves setting up light 
sources, cameras and surface 
materials to create a specific 

look which captures the  
mood of a shot. 

In Houdini, you will employ  
a wide range of skills to create 

a well lit shot and here are 
some of the tools you will  

be working with.

Houdini offers a great framework for lighting and ren-
dering your shots whether you use Houdini’s built-in 
renderer Mantra or any number of third party ren-
derers such as RenderMan. You can even mix and 
match renderers within the same scene and render 
out different passes with the look you want.

Lights and cameras
To render out your scene, lights and cameras play a 
key role. The camera defines the framing of your view 
while the lights define its mood and character.
Creating - At the top of the workspace, you will 
find the Light and Camera shelf which contains a 
variety of different light types and cameras including 
a stereoscopic camera.

Positioning - You can manipulate handles belonging 
to lights/cameras or you can look through the lights/
cameras, Lock Camera/Light to View and then use 
Tumble, Track and Dolly to update their position.   

Materials
Materials contain the shading information needed to 
determine how an object will react to light in your 
scene. Materials can use properties such as diffuse, 
reflection and bump. You can also texture map mate-
rials for even more surface detail.  
Palette  - The palette shows all your materials no 
matter where they are in your scene hierarchy. There 
is also a gallery for creating new materials. 
VOPs - VEX operators let you build shaders using 
an interactive node-based interface. The Shader FX 
menu beside each parameter in VOPs, makes it even 
easier to create and connect these nodes.
VEX - A vector expression language used to create 
shader code and custom nodes.  VOP nodes generate 
VEX code as you wire them together. 

Render  
OUTPUT NODES
Houdini has a dedicated context just for output nodes 
called Render Operators [ROPs]. In this context, you 
can set up these ROPs depending on whether you 
are rendering to Mantra, a third party renderer or to 
another format such as bgeo for geometry.
Render Layers - The Mantra ROP contains op-
tions for adding image planes to your final rendering. 
These can be used to break up a rendering into ren-
der layers on a per light basis. These extra channels 
can be stored as extra channels in OpenEXR files for 
use by the compositing team. 
ROP Dependencies - Render Operators can be 
wired into networks with the data flow indicating render 
dependencies. For instance a Compositing ROP could 
be fed by Mantra ROPs which are in turn fed by Geom-
etry ROPs. To render the Compositing ROP, the nodes 
feeding into it will need to be rendered first.
Wedging- The Wedge ROP lets you create multiple 
images or sequences using a range of values assigned 
to any parameter in your scene. This is great for 
quickly generating multiple iterations of your work.

Rendering 
WORKFLOW
There are a few different ways of rendering your 
scene in Houdini. Here are some of the key methods.  
Render View - The Render View panel offers an in-
teractive photorealistic rendering [IPR] environment 
which lets you rapidly tweak and refine your shot.
Render to Mplay - You can also send renderings to 
Houdini’s Image Viewer called Mplay. You can then 
use the viewer to evaluate your work and export im-
age sequences as movies.
Render Region - You can also use the Render 
Region tool in the scene view to drag a bounding box 
over your scene and render the chosen area. This is 
good for quick evaluations of lighting and shading.  

HQueue
HQueue is a Python-based job manager which can 
distribute Houdini jobs and Mantra renderings to 
local render farms. HQueue jobs can be launched 
using a ROP then monitored using HQueue’s artist-
friendly web interface.
The same HQueue technology is used by Houdini 
to connect artists to the Amazon EC2 Compute 
Cloud which provides access to a flexible system of 
render nodes for a reasonable hourly rate. 

Compositing Tools 
For Lighters
Houdini includes an environment for using Composit-
ing operators [COPs] to build node-based composit-
ing networks. The toolset includes color correction, 
rotoscoping and retiming tools and gives artists the 
tools to test out render layers and prepare output 
files for a compositing team which may be using an 
outside compositor.

THIRD PARTY 
RENDERERS
The lighting and rendering pipeline in Houdini works 
well with Mantra but can easily be adapted to other 
third party renderers. Pixar’s RenderMan is well 
supported out of the box and other renderers can be 
integrated using Python to develop custom hooks. 
Once set up, you would use ROPs specific to your 
chosen renderer and can choose to mix and match 
these with Mantra ROPs as needed.

Lights and Cameras Shelf - Go 
here to create lights and cameras. 
You can choose from point lights, 
spot lights, areas lights, environ-
ment lights and more.

Mantra ROP - This node contains 
all the parameters needed to define 
a Mantra rendering including mul-
tiple channels for setting up render 
layers. You can start a rendering 
from here or use the Render menu.

Material Palette - The palette is 
where you add materials to your 
scene then assign them to objects. 
Double-click on material icons to 
go to their VOP network.

Material Gallery- The gallery  
contains a library of pre-built mate-
rials which you can use right away.

Render Menu - Go here to create  
render operators, start a render or 
set your render options.

Channel Menu - When you render 
deep raster files you can access 
the channels using this menu.

Inspect Tool - If you RMB-click  
in the render view you get access 
to special tools such as Inspect.

Render View - The Render view 
gives you an interactive photoreal-
istic rendering [IPR] environment 
which lets you rapidly tweak and 
refine your shot.
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HOUDINI’S 
BUILT IN 
RENDERER
Houdini comes with a built-
in renderer called Mantra. 
This production-proven so-
lution offers you a renderer 
which is a hybrid of the 
RenderMan style rendering 
called Micropolygon and 
the newer Vray style ren-
dering called Physically-
based Rendering [PBR].
The new approach offers more 
realistic bounced light while the 
traditional style offers speed 
through features such as fast 
shadows and motion blur. 
In Mantra you can combine 
these features within a single 
renderer. Mantra is also a very 
good solution for rendering 
volumes such as smoke or fire.
 



VFX and 
Simulation

Houdini’s node-based workflow 
offers an ideal environment for 

creating visual effects. From 
particles to rigid body and fluid 

dynamics, Houdini provides 
tools for every situation.

Houdini’s strength in VFX is  
a result of not only strong 

particle and simulation tools 
but also a procedural approach 

which make your effects easy to 
control and thereby directable. 

In production, this control and 
flexibility is critical and often 
makes a big difference when 

under a tight deadline. 

A visual effect brings together modeling, animation, 
rendering and simulation into an integrated system 
of related events. You can easily choose from a wide 
range of VFX tools in Houdini or combine them to 
create even more sophisticated results. 

Particles
Particles are points in space which are acted upon 
with forces. This gives them properties which have 
a natural feel, making them ideal for a number of 
different VFX. In Houdini, you control particles in the 
Particle Operator or POPs context.  

 

Fluid  
DYNAMICS
Liquids and gases exhibit specific behaviors which can 
be mimicked using fluid solvers in Houdini. These are 
found in the Dynamic operator or DOPs context and 
offer a number of approaches to fluid mechanics.

Voxel Fluids - Otherwise known as Grid-based 
fluids, this approach simulates your fluids inside a 3D 
container which applies a 3D resolution to the fluid 
calculations. The more you increase the resolution of 
the container, the more detail you will get in your sim.

You can create liquid, smoke and fire using this ap-
proach with fields such as heat, turbulence and dis-
sipation defining how the fluid moves around the grid.

Particle Fluids - For liquids which require a more 
dynamic splashing effect, particle fluids using the 
FLIP solver are best. You can feed the results through 
a particle network for even more control. 

Rigid Body  
Dynamics
To simulate rigid objects bumping into each other or 
fracturing into tiny pieces, you can turn to Houdini’s 
Rigid Body tools. With instancing tools and various 
constraints, this solver can be used to achieve a wide 
range of destruction shots as seen in many VFX shots.

DUST, DEBRIS 
AND WHITECAPS
As you smash up objects or create dynamic fluid 
sims, you can use data from the sim to generate sec-
ondary effects such as dust debris or whitecaps. 

CLOTH Dynamics 
and plastic deformations
Houdini includes a cloth solver which is primarily 
used in Houdini for plastic deformations where an 
object bends and crushes on impact. You can also 
simulate tearing to show panels being ripped apart.
The cloth solver can also be used for simple cloth 
sims but is not yet ideal for fully clothed characters. 
Watch for that capability in future releases.

WIRE AND FUR  
Dynamics
From tree branches to hair and fur there are many 
situations where Wire dynamics come into play. This 
solver is similar to the cloth solver but only has to 
worry about curves instead of complete surfaces.
When setting up fur, you have a full shelf of tools to 
help you set up and groom your creature including an 
Add Dynamics tool to apply the wire solver.

Dynamic Tools - The Rigid body, 
Fluids, Pyro FX, Cloth and Wire 
tools are found on different shelves 
on the right. These tools let you 
convert objects into dynamic 
objects and then apply forces and 
constraints to affect simulations.

Dynamic Network - This is where 
the dynamic operators [DOPs] are 
wired together. While other  
network types flow from the top 
down, nodes interact both up and 
down a DOP network. This way  
the parts of a simulation take into 
consideration all the other parts.

Details View - This view lets you 
analyze the objects, forces and 
constraints involved in a dynamic 
simulation and keep track of how 
they are interconnected. 
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INTEGRATED 
DYNAMIC 
SOLVERS
In the DOPs context, 
you can integrate 
different solvers into the same 
network. For instance, fluids 
and rigid bodies can interact to 
create a richer simulation which 
takes into account all the related 
objects. This ability to integrate 
solvers is one of the key benefits 
of doing your sims in Houdini.

FIRE AND 
SMOKE FX
With Houdini’s Pyro FX 
tools, you can create high 
quality smoke and fire right 
from the shelf. 
Utilizing cutting edge up-
resing technology, Pyro FX 
makes it possible to create 
a low resolution simulation 
in planning out a shot, then 
increase the resolution on subse-
quent passes to add higher level 
of details and refinement. 
Pyro FX comes with several 
pre-made effects such as Bil-
lowy smoke and Fireball to give 
artists a head start when setting 
up a simulation. Mastering Fire 
and smoke effects are a big part 
of being a visual effect artist and 
Pyro FX gives you production-
quality results built with the 
creative process in mind.
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THE TAB  
MENU
To access tools in both 
the Scene view and the 
Network editor, use the 
Tab key to bring up a menu of 
operations. If you know which 
tool you are looking for then you 
can begin spelling out the name 
and a list of tools using those 
letters will appear.

Keyboard 
Shortcuts

As you begin working with 
Houdini, it is useful to become 

familiar with some typical  
keyboard shortcuts which are 

built right into Houdini. 

To create your own  
custom shortcuts use the  

Edit > Hotkeys menu item or 
press Ctrl+Alt+Shift and then 
LMB-click a UI item to call it 

up in the hotkey editor.

TOOLS

	 Select	 s
	 Move	 t
	 Rotate	 r
	 Scale	 e
	 Handle	 Enter
	 View	 Esc
Tool Menu	 Tab
Repeat Last Tool	 q

SELECTION MODES

	 Objects	 1
	 Points	 2
	 Edges	 3
	 Primitives (Faces)	 4
	 Vertices	 5
	 Particles	 6
	 Dynamics	 7
Toggle Object/Geometry	 F8

SNAPPING

	 Grid	 x
	 Primitive (Curve)	 c
	 Point	 v
	 Multi-Snapping	 Ctrl[Cmd] + j

VIEW TOOL

	 Tumble	 Space + LMB
	 Pan	 Space + MMB
	 Dolly	 Space + RMB

Home Grid	 Space + h
Home All	 Space + a
Home Selected	 Space + g

PANES

Scene View	 Alt[Opt] + 1
Network View	 Alt[Opt] + 2
Parameters	 Alt[Opt] + 3
Tree View	 Alt[Opt] + 4
Textport	 Alt[Opt] + 5 
Channel Editor	 Alt[Opt] + 6
Material Palette	 Alt[Opt] + 7
Details View	 Alt[Opt] + 8
Context View	 Alt[Opt] + 9

Maximize Pane	 Ctrl[Cmd] + b
Split Pane Left/Right	 Alt[Opt] + [
Split Pane Top/Bottom	 Alt[Opt] + ]

PANE TABS

New Pane tab	 Ctrl[Cmd] + t
Tear off Pane tab	 Alt[Opt] + Shift + c

Next Pane tab	 Ctrl[Cmd] + Pg Down
Previous Pane tab	 Ctrl[Cmd] + Pg Up

Close Pane tab	 Ctrl + w
Close All Pane tabs	 Alt[Opt] + /

SCENE VIEW

Expand View	 Space + b
Select View	 Space + n
Perspective View	 Space + 1
Top View	 Space + 2
Front View	 Space + 3
Right View	 Space + 4
UV View	 Space + 5
Toggle Wireframe/Shaded	 w
Display Options	 d

SCENE VIEW LAYOUT

Single View	 Ctrl[Cmd] + 1
Four Views	 Ctrl[Cmd] + 2
Two Views Stacked	 Ctrl[Cmd] + 3
Two Views Side by Side	 Ctrl[Cmd] + 4
Three Views Split Bottom	 Ctrl[Cmd] + 5
Three Views Split Left	 Ctrl[Cmd] + 6
Four Views Split Bottom	 Ctrl[Cmd] + 7
Four Views Split Left	 Ctrl[Cmd] + 8

ANIMATION

Set Keyframe	 k
Toggle AutoKey	 Alt[Opt] + k
Key Handle	 Ctrl[Cmd] + k
Key Translate	 Shift + t
Key Rotate	 Shift + r
Key Scale	 Shift + e

TIMELINE

Play Forward	 

Play Back	 

Next Frame	 

Previous Frame	 

First Frame	 Ctrl[Cmd] + 
Next Scoped Key	 Ctrl[Cmd] + 
Previous Scoped Key	 Ctrl[Cmd] + 

Scrub Timeline	 LMB
Select Keys	 Shift + LMB
Move/Scale	 Shift + MMB

HELP

Tools Help on Mouse Over	 F1

** Control [Ctrl] and Alt are used for Windows and LINUX  systems while Command [Cmd] and Option [Opt] are used for the Mac


